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TelQA Test is designed primarily for testing web-based applications. However, many companies still use
"legacy" applications designed for use with character-cell terminals such as VT100, VT220, VT320 etc. In
many cases web-based front-ends have been developed to provide a modern interface to such applications,
but there are often still users of the original terminal-based interface, usually connecting via terminal
emulator software rather than a physical terminal. There may still be a need to test such applications and
TelQA Test provides comprehensive facilities to do so.

TelQA Test enables a script to be produced by recording the interactions of a user with a terminal-based
application, and as with web-based applications the interactions may be stored either as a TelQA SmartScript
or as a C# or VB.NET based script. Once a script has been recorded, it can then be edited to allow large
numbers of Virtual Users (VUs) to be replayed with unique identities. The same range of SmartScript
features available for web-based scripts can also be used with terminal-based scripts. In fact, once the script
has been generated, the full functionality of TelQA Test is available independent of the application type. Itis
possible to produce a test which includes both web-based and terminal-based scripts, and it is even possible
to combine web and terminal interactions within a single script.

TelQA Test currently supports terminal-based applications which can be accessed using the Telnet protocol,
and which support the VT range of terminals including VT100, VT220 and VT320 or other terminals which
use ANSI escape sequences. If you have a requirement outside this scope then please contact TelQA Limited
to discuss your requirement.

The following sections describe how to use TelQA Test to test a terminal-based application. The examples
described use a simple credit card application running under OpenVMS.
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By default, TelQA Test does not display the option to record a terminal-based script, as this is not required
for web testing. In order to enable the feature, select the Tools>Options menu item and change the item
"Support Terminal Scripts" to have the value "Yes", then click OK.

If not already open, open the Project window using View>Project. Right click the SmartScripts node of the
project tree and select the Record Script option:

= Project ‘Project1”

..... @ Tests

| __] CodeScripts

(=] Va ) Mew Script

= Record Script

ImportScript

Enter a suitable name and description and change the Protocol value to "Telnet":

- 1
Record Script &J
Name TestCCApplication
Description Test credit card applicatior
P
e
L

Click OK, then the Terminal Emulator Connection window will be displayed:

r -
Terminal Emulator Connection ﬁ

Emulator Command  C:\Program Files (B6)\TelQA\TelQA Test\TelQA 2w (]

Emulator Arguments

Server Address 152.168.0.101 Port 23
Terminal Type VT320)] -

In order to record the terminal session, TelQA Test requires the use of a terminal emulator which the user
will use to interact with the target application. Any terminal emulator which supports the VT terminal types
may be used, including the HyperTerminal application which is included in Windows.

When you initiate the recording of a terminal script, TelQA Test interposes a proxy Telnet server between
the terminal emulator and the application. This proxy server listens on port 8023 by default but this may be
changed by altering the value of "Telnet Capture Port" in Tools>Options. The terminal emulator must be set
up to connect to this port rather than directly to the target application. Most emulators allow you to save
session settings to a file then invoke this file as a shortcut to connect directly without needing to set up the
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connection values each time. Shortcut files for HyperTerminal and Reflection are included in the TelQA Test
installation directory.

In the Terminal Emulator Connection window, set the Emulator Command by browsing to the appropriate
shortcut file or directly to the emulator executable. If your emulator requires any command line arguments
then these may be entered in the next field. Enter the name or IP address of the target application server in
the Server Address field, and change the Port value if this differs from the normal Telnet default of 23.

Click OK to commence recording. This will start the terminal emulator, which should connect to the target
application server. For the purpose of this document we will run the credit card application, create a new

customer account and issue a credit card to the customer.

After connecting to the application server, the OpenVMS login prompt is displayed and we login:

{4 TelQA.r2w - Reflection for UNIX and Digital = | B |l
File Edit Connection Setup Macre Window Help
el &S T ¥ r e | K2
OpenlA% AWP DEC 3000 Aodel 400
Usernane: nall
513 VT400-7 -- localhost via TELMET

Run the credit card application:

rﬁ. TelQA.r2w - Reflection for UNEX and Digital [ =|:[El g1
File Edit Connection Setup Macre Window Help
D & D T »r e | K2
DERD: (RG] THAT4: 25-SEP-2009 14:33:35 J
AHP S CARDDERD
236,15 VT400-7 -- localhost via TELMET P
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The main application screen is displayed, showing the available options. Select option 1 to add a new
customer:

-
14 TelQA.r2w - Reflection for UNIX and Digital —

File Edit

=y =

Setup Macro Window Help
e A2

Connection

HIZA Aain A2nu

Custoner Haintenance Inquiries

4. Custoner Account

1. Add Men Custoner
5. Transaction History

£. Issue Mew Card
3. Post Tranzaction

Option & 1

|
VT400-7 -- localhost via TELNET

265, 40

Enter the new customer's details and the application prompts to confirm that the details are correct:

£y TelQA.r2w - Reflection for UNIX and Digital = | B |t

File Edit

DedE &

Setup Macre Window Help
B | -0

Connection
b o | A?

- o o e rY
2o -Sep-2 0% 1557310

Hedw Custoner

Account Mudber: 00003
Custoner 's Nane!
Street Address: 12 HATH STREET

Citw: SOHETOMN
County & PostCode: HMYIHERE BE1Z 2C0

Date of Birth:
Hother's Haiden:

Credit Linit:

la/asds
JOMES

000, g

Iz thi= infornation correct 7 %

118, 32

WT400-7 -- localhost via TELMNET
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Return to the main screen, select option 2 to issue a credit card, then enter the account number which we
have just created:

"_;_-‘h AXPO.r2w - Reflection for UMIX and Digital -Elﬂg

Eile Edit Connection Setup Macro Window Help
DR & =@ @7 » o K2

Natuifay Bank 28-5ap-2003 {01248 ;I

I=zzue MeH Card

! Hatuifax Bank

HIEA

4BE0534120020001

) Valid fron: F Expires end: /F ,

Rccount: Q00030

| 285,15 | | VT400-7 -- 192.168.0.101 via TELNET | | |
.

Enter a validity period of 24 months and a credit limit of £3000. The application prompts to confirm the
operation:

& TelQA.r2w - Reflection for UNIX and Digital l = | E ﬂ1
File Edit Connection Setup Macre Window Help
D@ & = .la 7 » o 2
Hatuifas Bark 25 JTENETET ;|

I=zzue Hed Card

IHEtHiFSH Eank

HIEA

SEZ0834120020001

BILL ZAITH
Valid fron: 10409  Expires end: 09/11

Add thiz record? & I

412,18 | | VT400-7 -- localhost via TELNET | | |

Ll

End the recording session by pressing the ' button in the TelQA Test Recorder control dialog:

TelQA Test Recorder @
LV " § = |
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The TestCCApplication script will now be displayed:

Welcome TestCCApplication 4 b
Bl L] SmartSeript TestCCApplication = Terminal Input Properties
= g Teminal Session Input Name Inputl2
% Teminal Input - Input Type Literal
Ty Teminal Input -mg™M Input String 3000~M

ﬁ Teminal Input - carddemo™M T 23
?3 Teminal Input - 1M
ﬁ Teminal Input - bill smith ™M
?3 Teminal Input - 12 main street ™M
% Teminal Input - "M
% Teminal Input - sometown ™M
& Teminal Input - anywhers "M
~Tg Teminal Input - ab12 3ed™M
T Teminal Input - 12/3/45"M
% Teminal Input - jones™M
o Temna ot~ 300w
ﬁ Teminal Input - “M
T—g Teminal Input - 1°M
ﬁ Teminal Input - “M
% Teminal Input - 2"M
% Teminal Input - 00003™M
?3 Teminal Input - “M
ﬁ Teminal Input - 24™M
?3 Teminal Input - “M

Synchronization Type WaitForCursor
Synchronization Timeout 30
+| Synchronization Cursor Position | 21, 19

Terminal Input Properties

Screen Before Input | Screen After Input

New Customer

Account Number: 00003
Customer's Name: BILL SMITH
Street Address: 12 MAIN STREET

City: SOMETOWN
County & PostCode: ANYWHERE ABLlZ 3CD

pate of Birth: 12/3/45
Mother's Maiden: JONES

Credit Limit: 3000.00%

Is this information correct 7 ¥

Note that for each terminal input, an image of the screen as it was immediately before and after the input is
displayed in the lower pane. This will assist in modelling the script as discussed in the next section.

When replaying a terminal-based script, some form of synchronization is normally required to ensure that
the application is in the correct state to receive each input. For a screen-based application like the credit
card application, synchronization using the cursor position usually works well. This approach requires that
the cursor is positioned at a specific point on the screen before the input is sent to the application. The
highlighted input above shows the text "3000" followed by the Return key (represented by M or Control-M)
being entered in the Credit Limit field, with the cursor at column 21 of line 19. Note that the screen image
below shows the state of the screen after the input.

The script is created using the "WaitForCursor" synchronization type by default. However, some
applications may be less amenable to synchronization using the cursor position, particularly if the input
occurs within an area of the screen which may scroll. In such cases the synchronization type
"WaitForScreenText" may be more suitable. This requires a specified text string to be present within a
specified area of the screen before an input is sent. The area may be specified as a rectangle of any size up
to the full screen size.

Each input has a synchronization timeout property which defaults to 30 seconds. If the specified
synchronization criterion is not met within this time, the VU will be aborted. The abort message in the event
log will show the input at which loss of synchronization occurred, and the actual and expected cursor
positions in the case of cursor synchronization, or the text string which was not found in the case of text
synchronization.
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After the new script has been generated, you can replay it using the toolbar Script Run button:

Script Run (») (b1

After the Script run has completed, open the Result View from the Script Run node in the Project Window.

E|J TestCCApplication
. EME] Script Runs
E\B 28-Sep-2009 14:50:13
g
(- | TestDel |_
- 1| TestWhile & Delete Results
----- |=| Variables [3]
Eg---»ﬁq- Data Collection Sets

Open Result View

Check that the Event Log does not contain errors. Errors are displayed in red. The contents of the log should
be similar to the example below (with different dates).

Display the Script Run Viewer by clicking the tab. Note that the full script used for the playback is listed,

L
[¥] Show Test Events @ All Events () Errors Only [ Show HTTP Requests
Time Stamp Source Evert
28-5ep-2009
14:50:13.14 Project1.3 TestCCApplication Test Started
14:50:13.15 Project1.8TestCCApplication Sampling Started
14:50:13.15 Project1.8TestCCApplication. 85equence Sequence Started
14:50:13.15 Project1.3TestCCApplication. $Sequence .1 Sequence lteration 1 Started
14:50:13.16 Project1.8TestCCApplication.85equence 1. TestCC Application  Task Started
14:50:13.52 Project1.8TestCCApplication $5equence . 1. TestCCApplication  Task lteration 1 Started
14:50:25.30 Project1.3TestCCApplication. $Sequence . 1. TestCC Application  Task keration 1 Completed
14:50:25.30 Project1.8TestCCApplication.£5equence. 1. TestCCApplication  Task Completed
14:50:25.30 Project1.8TestCCApplication. $Sequence. 1 Sequence teration 1 Completed
14:50:25.30 Project1.8TestCCApplication. $5equence Sequence Completed
14:50:25.30 Project1.8TestCCApplication Sampling Completed
14:50:25.30 Project1.8TestCCApplication Test Completed

together with a trace of the script steps actually executed.

Evert Log |;

[SRY#) Smart Script TestCCApplication
= [} Terminal Session
% Temminal Input -

| Propefties| Trace |

Start SmartScript TestCCApplication -
Teminal Session "192.168.0.101:23" connected

% Teminal Input - mg™M

T Teminal Input - carddema ™M
% Teminal Input - 1°M

% Teminal Input - bill smith ™M
% Teminal Input - 12 main street ™M

% Teminal |nput1 Teminal Input - 12 main street™M ]
ﬁ Teminal Input - sam

% Teminal Input - anywhere ™M
Ty Teminal Input - ab12 3ed™M
T Teminal Input - 12/3/45"M
% Teminal Input - jones™M
T Teminal Input - 3000°M
% Teminal Input - M

% Teminal Input - 1°M

% Teminal Input - “M

% Teminal Input - 2°M

A5y Teminal Input - 00003"M
% Teminal Input - "M

% Teminal Input - 24™M

% Teminal Input - "M

own TV

Teminal Input Input1: "mg™M"
Teminal Input Input2: “carddemo“M”
Teminal Input Input3: "17M"
Teminal Input Input4: "bill smith™M"
Teminal Input Input5: "12 main street™M"
Teminal Input Input§: "“M"

Teminal Input Input7: "sometown™M"
Teminal Input Input: "amywhers™M"
Teminal Input InputS: "ab12 3cd™M"
Teminal Input Input10: "12/3/45™M"
Teminal Input Input11: “jones™M"
Teminal Input Input12; "3000"M"
Teminal Input Input13; " M"
Teminal Input Input14: "1°M"
Teminal Input Input15: "“M"
Teminal Input Input16: "2°M"
Teminal Input Input17: "00003™M"
Teminal Input Input18; “"M"
Teminal Input Input19: "24™M"
Teminal Input Input20: "“M"

Teminal Session "192.168.0.101:23" disconnected
End SmartScript TestCCApplication

Close the Script Run tab and Results View tab.
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After a new script has been recorded it will generally be necessary to "model" it in order to make it usable
within a multi-VU test. This involves replacing fixed values entered during the recording with values
generated dynamically during the test.

A simple example of this requirement is the use of the account number in the credit card application. A new
account number is generated by the application when the Add New Customer option is selected. This
number is subsequently entered manually when the Issue New Card option is selected, in order to specify
the customer to whom the card is to be issued. If you run the script as recorded you will note that the same
value, 00003, is entered each time as the account number for the credit card issue, rather than the value
generated by the Add New Customer function.

In order to fix this problem, we will extract the account number issued by the Add New Customer function,
save it in a variable, and enter this variable value as the account number for the Issue New Card option.
First, select the input corresponding to the selection of the Add New Customer option and select the Screen
After Input which shows the account number allocated by the application. Select this by holding down the
mouse at the start of the field and dragging until the whole field is selected as indicated by a grey
background. Now right-click and select the option to Set Variable from screen text:

3 J SmartSeript TestCCApplication » [ = Terminal Input Properties
=I- [, Teminal Session Input Mame Input3
-0y Terminal Input - E Input Type Literal
-y Teminal Input - mg ™M Input String 1M E
T Teminal Input - carddemo ™M G 15
% N Synchronization Type WaitForCursor

Y’g Terminal Input - bill smith "M N Synchronization Timeout 30
% Terrn?na\ Input - _12 main street "M +| Synchronization Cursor Position | 39, 18 i
?—g Teminal Input - M i

" S —_— 5 | Terminal Input Properties

New Customer

Account Number:

Customer's Name:

Street Address: Copy

City: Set Variable from screen text

county & Postcode:

cate of Birth:
Mother's wMaiden:

credit Limit:
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A Save To Variable Node will be added below the Terminal Input and the selected text will be shown
coloured to indicate that it is being used as the source of a variable. Change the variable name in the
property grid to a meaningful value, e.g. AccountNumber.

=1 J SmartScript TestCCApplication1 » [# |-/ Script Action Properties
= B Terminal Session Address Screen, (21,9,5,1)
?g Teminal Input -
% Teminal Input - mg”™M
?g Teminal Input - carddemao™M
B% Teminal Input - 1°M
d
% Temninal Input - bill smith ™M
: ?g Teminal Input - 12 main street™M
o T : | Script Action Properties

Screen Before Input | Screen After Input |
GEP

m

Variable Name | Accounthumber

Sep-2008 1Lt

New Customer

Account Number:
Customer’'s Name:

Street Address:

City:
County & PostCode:

pate of Birth:
Mother's Maiden:

Credit Limit:

We now need to use the AccountNumber variable as the source for the account number entered when
issuing a new credit card. Select the input corresponding to the entry of the account number, change the
Input Type to Variable and select the variable name "AccountNumber". Leave the Input Format String as
"{0}*M"; this will ensure that a carriage return is entered following the account number.

»

..... % Teminal Input - amywhers ™M = Terminal Input Properties

----- T Teminal Input - ab12 3cd™M Input Name Input17
----- T Teminal Input - 12/3/45™M Input Type Variable
""" % Teminal Input - jones ™M Input Variable Name Accountiumber

----- T Teminal Input - 3000°M

Input Format String {o}~m
----- ?g Teminal Input - "M Think Time 1
""" % 1‘3"'"?”3: :“F'Lrt N 1|'\"|M Synchronization Type WaitForCursor
""" % eminl Input - Synchronization Timeout 30

----- ?—% eminal Input - 2°M = [ ronization Cursor Positio
_ = 21

..... . . Synchronization Cursor Positi 10

----- ?—% eminal Input - "M Input Format String

""" % Teminal Input - ’:‘}4—\M The format string used to format the input. The value of the
..... ﬁg Teminal Input - "M - [f| input variable will replace {0}.

Screen Before Input |Screen After Input

Issue New Card

Noatw i fa=x E a n k

WIZA

48Z08541200z20001

valid from: Expires end:

account: ||
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If you now run the script again and view the Script Trace, you'll note that the original input of 00003 has
been replaced by the account number displayed in response to Add New Customer.

The following are some examples of other modelling techniques that could be used within terminal-based
scripts. Note, however, that most of these are equally applicable to web-based or other types of script:

1. Inputs such as name, address etc. may be obtained from List, Table or Database variables. The
TelQA Getting Started Guide includes examples of the use of List and Table variables for entering
dynamic data.

2. The selection of input data may be randomized using a Randominteger variable in conjunction with a
Switch script step. Again, this technique is illustrated in the Getting Started Guide.

3. Conditional script processing may be achieved by using If/Then/Else script steps, checking the text
within an area of the screen to determine the action to be taken.
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